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How It Works
FinePrint is a printer driver that sits between an application and a physical printer.    The 
FinePrint printer driver captures output from the application, scales it, applies stationery and
then sends it to the destination printer.

Tip:    Sometimes it is desirable to have different settings for the physical printer depending 
on the FinePrint layout.    In this situation, you can install the physical printer under a 
different name and change the settings for that driver.    Both drivers will appear in the 
FinePrint Printer combo box and you can select the correct one without having to go the 
printer driver to change the settings.

To operate:

1.    Open any application
2.    Load your documents as normal
3.    Select the Print command from the File menu
4.    Select the "FinePrint driver" item from the printer list
5.    Click OK
6.    Wait for the FinePrint dialog box to appear.
7.    Make your printing selections in the FinePrint dialog and press OK.



FinePrint Uses
Saving paper:
Using 2, 4, or 8 up layout options can save a significant amount of paper when printing 
drafts, transcripts, computer source code, contracts, email, web pages or any other internal 
document.

Watermarks
Watermarks can be used to identify particular document properties or mark documents for 
archival storage.    Examples are Confidential, Draft, etc.    Custom watermarks can also be 
created.

Archival Document Storage
Documents printed 4 or 8 up can be stored in a much smaller space than documents printed
in standard 1 up mode.

Booklets
The booklet feature can be used to create compact 2 up, double-sided booklets. 

Scaling
FinePrint can scale a document to any size sheet of paper.    For example, legal size 
document content can be printed on letter size paper or A4 content can be printed on letter 
size paper.

Forms
Forms can be created from any application.    You can create a form and then print other 
content on top of the form as you would with pre-printed letterhead.    See FormFactory for 
further information.



Layout
The Layout options allow you to set the number of pages to be printed on a single sheet of 
paper as well as apply stationery and forms. 

Bypass
Use this setting if you want the output to go directly to the printer without any FinePrint 
modifications or scaling.    With this feature, it is convenient to set FinePrint as your default 
printer driver and use the Bypass option when you want output to go directly to your 
destination printer.

1 up
Use this setting when you want to print a document in the same size as it would print 
without FinePrint but want to print on FinePrint electronic stationery or forms.

2 up
This is the default setting and is the most commonly used option.    Almost all documents are
readable printed at 2 up which results in a 50% reduction in printed paper.    Document 
drafts, legal briefs, email, computer source code, etc can be printed at 2 up with excellent 
results.    It is also the best setting for printing to a fax modem.    Note that fax users should 
use the high-resolution (200dpi) setting on the fax modem software before printing.

4 up
This is an excellent choice for those documents which contain text in sizes larger than 10 
points.    The text is generally readable and paper usage is reduced by 75%.    Review copies 
of large manuals may be printed using 4 up as well as court transcripts and presentations.    
4 up is also a good choice for archiving documents that must be stored in printed form. In 4 
up mode, the page ordering feature is available.

8 up
This setting is a good choice for handouts of presentations or any other document where the
point sizes are larger than 14.    8 up offers the maximum paper compression and is suitable 
for archival documents. In 8 up mode, the page ordering feature is available.

Booklet
This setting will create a 2 up double sided booklet.    Booklets are useful for presentations, 
brochures, or other applications where a compact format is desired.

Borders

Smart - draws borders according the Ordering setting (see below).
On - draws borders around each page
Off - turns borders drawing off

Ordering 

Down - draws the pages down before drawing them across the sheet of paper in 4 and 8 up 
modes.    For example, in 4 up mode, the page ordering would be:

1 3
2 4

Across - draws the pages across before drawing them down the sheet of paper in 4 and 8 
up modes.    For example, in 4 up mode, the page ordering would be:



1 2
3 4

PDF - use this check box if you are printing landscape Acrobat (PDF) documents. 

R to L - this option appears when a Middle Eastern or bidirectional language version of 
Windows is being used.    Selecting this option will reverse the ordering of pages within a 
page and will also make booklets begin open on the left side instead of the right side.

Margins

This combo box allows you to adjust the white space around the content within a page.    The
options are:

none - no margins at all, provides the largest output 

small    - small amount of margin.    This is the default setting and gives a bit of space 
between pages 

medium - medium margins

large - large margins

original - the margins that are used by the original document.    No scaling is done with this 
setting.    This setting is automatically selected for use with forms where alignment is 
important.

Printer

Select the destination printer from this combo box.      Network printers, fax drivers and other
types of printer drivers can be selected here.

Note:    FinePrint emulates the printer that was selected in this combo box at the time 
printing occurred.    If you want to ensure that no scaling occurs to make output fit into 
printers with different hardware margins, select your destination printer before printing.    
You can select the destination printer by setting the defaults.

Copies

Set the number of complete, collated copies here.    Default is 1 copy.



Previewing and deleting pages
Previewing

FinePrint will display the actual pages of the print job when it is run in    "after printing is 
complete" mode.    The scroll bar to the right of the page display view can be used to scroll 
through the document.    Moving the cursor over a page and clicking with the magnifying 
glass cursor will zoom in on the page in a large window.    Pressing the Esc key or clicking on 
the zoomed page with the magnifying glass cursor will revert to normal mode.

Deleting and undeleting pages

You can delete a single page or an entire job from the set of pages to be printed.    This is 
useful for deleting empty web pages from a web browser print job or to delete pages that 
were accidently printed.    Simply right-click the page you want to delete and select either:

Delete this page - deletes the current page
Delete this job - deletes the current page and all other pages in the job that contains the 
page.
Delete page mode - enters Delete page mode (see below)

To undelete a page or job, right click on any page and select one of the following:

Undelete all - undeletes all previously deleted pages and jobs.
Show deleted - displays deleted pages with a red "X" drawn over them.    In this mode, the 
following options are available by right-clicking on a page:

undelete this page - undeletes the page
undelete this job - undeletes the job containing the page
hide deleted - hides the deleted pages

Delete Page Mode
While in delete page mode, clicking on page deletes it, showing a red "X" over it.    To 
undelete the page, click it again.    To exit delete page mode, right click and select "Normal 
mode".

To selec t a range of pages to delete, click on the start page, move the cursor or scroll to 
the end page, hold the Shift key and click on the end page.

Note: if show deleted pages is selected, deleted pages are drawn on the screen but they are
not printed.



Deferred Printing
FinePrint can defer the printing of jobs so that you can accumulate a large number of pages 
before printing.    This is useful for short items such as web pages or email that might not be 
long enough to print at 2 or 4 up.    

Press the Defer button at the bottom of the FinePrint window.    When the Defer button is 
pressed for the first time, a window will appear in the Task Bar that indicates the number of 
deferred jobs.    When you want to print the deferred jobs, simply double-click the FinePrint 
icon in the Task Bar and the FinePrint dialog will appear allowing you set the print options.

You can disable the display of the FinePrint dialog box by pressing the Defer All button.    The 
Defer/Defer All button is toggled by pressing the Shift key in while in the Layout tab.



Creating and using stationery
A saved collection of header, footer and watermark is referred to as a stationery.    Stationery
can be saved and applied to documents.    FinePrint comes with a few pre-defined stationery 
items.    You can also create your own custom stationery.    Click the Stationery tab located at 
the top of the FinePrint window to edit and create new electronic stationery.    

Stationery Combo Box
This box allows you to select the stationery to edit.    Simply select the stationery you want 
and it will be shown in the preview window.

New button
Select this button when you want to create a new blank stationery.    A dialog box will appear 
prompting you for the stationery name.

Delete button
Select this button when you want to delete the currently selected stationery.    

Rename button
Select this button when you want to rename the currently selected stationery.    

Header button
Displays the header (the text at the top of the preview window) and allows it to be edited.

Footer button
Displays the header (the text at the bottom of the preview window) and allows it to be 
edited.

Watermark button
Displays the watermark (the text at the center of the preview window) and allows it to be 
edited.

Job Name button
Prints the name of the print job.    The job name is dependent on the application but typically
it is the name of the application followed by the file name.    An example of a job name is: 
Microsoft Word - MyFile.doc
 
Date button
Inserts the current date into the text.    The date will be updated whenever the document is 
printed.

Time button
Inserts the current time into the text.    The time will be updated whenever the document is 
printed.

Page Number button
Inserts the page number and the total number of printed sheets.    This can be used for 
documents that do not have the page number as part of the document content.

Other System Information
In addtion to the system information available by using the buttons described above, there 
are three addtional items available by typing these words into the edit boxes for the 
stationery:

<User>    Substitutes the user that the machine is registered to



<Printer> Substitutes the name of the currently selected printer
<Computer>    Substitutes the network name of the workstation currently running

Change Font button
Changes the font of the currently selected stationery header, footer or watermark.    The font
displayed in the preview window is not the same size as it will appear on the paper when 
printed.



Printer driver options - setting defaults
These options are available from the FinePrint printer driver icon in the printers folder.    
Right-click the FinePrint icon and select Properties on Windows 95/98 systems and Document
Defaults on Window NT.

Paper size
FinePrint supports a large number of paper sizes.    This option sets the default paper size.
 
Orientation
Set this option to either portrait or landscape.
 
Show Fine Print Dialog
· After printing is complete
This is the default mode.    The FinePrint dialog box is displayed after the application has 
completed spooling the job to the printer.    In this mode, the output is available for preview 
by FinePrint.    There may be a delay between the time that the application finished the job 
and the FinePrint dialog appears.

· Before printing starts
Use this mode if you have a long print job and you do not want to wait until the job finishes 
before leaving your computer.    Preview is not available in this mode, but SmartScaling will 
be done.

· Not at all
This mode is useful is you never or rarely change your print settings.    The FinePrint dialog 
will not appear and the job will be sent to the printer using the previously defined settings. 



Stationery Combo Box
This combo box allows you to select from a list of extisting stationery .    When you select a 
stationery, the preview display will update to show you how the page will appear when 
printed.



Double Sided Printing
FinePrint supports printing on both sides of the paper.    This procedure is referred to as 
duplex or double-sided printing.      Set the correct paper handling in the Options dialog box.



Options Dialog
This dialog allows changing the settings for each of the available printers.    Since printers 
have different methods of paper handling, this dialog allows you to have different settings 
for each.

Duplex Processing

There are three options and you must select the correct one for proper creation of double-
sided pages and booklets.    It is not always obvious which is the correct method so 
experimentation may be required:

· Printer has automatic duplex
Some printers have special hardware that supports double-sided printing.    Select this 
option if your printer has duplex hardware.    If your printer is not capable of automatic 
duplex printing, FinePrint, use one of the Manual Duplex choices below.

· Manual Duplex (paper is placed FACE UP in the tray)    
Use this choice if your printer requires to you re-insert the paper with the printed side 
facing up (visible) in the paper tray.      

· Manual Duplex (paper is placed FACE DOWN in the tray) 
Use this choice if your printer requires to you re-insert the paper with the printed side 
facing down (not visible) in the paper tray.

In either of the Manual Duplex modes, after FinePrint is done printing all of the front sides of 
the sheets, a dialog box will appear asking you to re-insert the pages into the printer for 
printing on the backside (side that has not yet been printed) of the sheets.    Press OK on the 
dialog box when the sheets have been re-inserted into the printer.

Duplex Orientation

The combo box alllows the selection of the orientation of the printed pages on the back side 
of the sheet of paper.    The options are:

· none - do not print duplex.    Print on one side only.
· long side - prints duplex where you flip the pages along the longer side of the paper.    

This is is useful for standard 3 hole binding.
 

· short side - prints duplex where you flip the pages along the shorter side of the paper.    
This choice is useful when you are binding a group of pages from the short side.  

· printer default - uses the long or short side setting as selected in the printer driver.

Printer Corrections
While FinePrint works correctly on most printers, some printers require a correction .    For 
this reason, FinePrint provides corrective measures.    They are:

Landscape duplex correction    
Some printers, notably the HP Laserjet 4000, require an adjustment in order to have the 
back sides of the sheets print in the proper orientation.    If you are printing booklets and the 
back sides are reversed, check this box.    This option applies only to printers that have 
automatic duplex.



PDF font correction
Check this box if your fonts are not printed correctly from Adobe Acrobat.        

Colored Text Processing
This combo box has options to control how colored text is processed.    
 
· Draw Normally

In most cases, colored text will print correctly with this option.

· Color correction
This option should be selected if colored text is missing or if watermarks do not print or 
are printed in black.

· Convert to black
Select this option if you prefer that all colored text be drawn as black.

Rotated Pages
This combo box has options to control how pages are rotated in the case where a document 
or group of documents has pages in both landscape and portrait orientations.
 
· Rotate entire page
            Use this option if your computer has a lot of memory and can rotate large graphics in a

single operation.

· Rotate in pieces
This is the default option and it uses memory most efficiently by rotating smaller sections 
of a page.

· Do not rotate
Select this option if you do not want pages rotated.    This will "letterbox" the page within 
the available area of the standard page rectangle.

Extra Margins
Set this option if you are missing any borders.    This adjustment increases the margin from 
the sheet by the specified number of pixels.

Test Page
FinePrint will print a test page showing how the various corrections affect the document.    It 
is useful for determining the correct number of pixels to apply to extra margins.

Reverse Printing
This option is useful for inkjet or other printers that require manual reverse collation of 
pages when printing is complete.    Note that this option may be required for proper 
operation of    double-sided printing if you have such a printer.    If your printer delivers pages
in the reverse order, you should check this option before attempting double-sided printing.    
Checking this option would, for example, print the pages of a 5 page document in the 
following order: 5, 4, 3, 2, 1.

Properties button
This button displays the properties dialog associated with the currently selected printer.





Registration Information
FinePrint is shareware, which means that you are expected to pay for it if you decide to use 
it. Registering with us entitles you to receive all future maintenance releases and unlimited 
technical support via email. 

You may register in one of three ways: 

Credit Card Only
via secure transaction at www.singletrack.com/registration.html.    You will receive your serial
number immediately

Fax and Mail
Click the Register tab on the FinePrint window and click the Registration Form button.    You 
will be prompted to enter a serial number from a previous version which will enable you to 
purchase an upgrade.    If you have not purchased a previous version, leave the fields blank.

Fill out the form and mail or fax to the address printed on the form.
 
Purchase Orders
Corporate purchase orders ay be mailed or faxed directly to us:
Single Track Software
701 Minnesota St #201
San Francisco, CA 94107
Fax: 415-695-4081

When payment is received, you will receive a registration key which you then enter into 
FinePrint after clicking the Register tab. Once you have entered your key, two things will 
happen:
 
1. The registration reminder message printed on each page will be removed. 
2. The 8 page limit will be removed. 

Your registration entitles you to use the product on Windows 95/98 or Windows NT on the 
same computer.



Technical Support
We are committed to providing excellent technical support for our customers.    Answers to 
frequently asked questions can be found on the Technical Support page of our website.      
Please check this page before sending a support request.

If you need support, please email us at support@singletrack.com.    Include the following 
information with your support request:

1.    Version of FinePrint you are running.
2.    Whether you are using Windows 95 or Windows NT.
3.    An exact description of your problem including any error messages displayed.    
4.    If you are having problems with a specific document, send an attachment containing the 
smallest part of the document that demonstrates the problem.    This will help us reproduce 
and fix the problem.
 



Creating and using forms (FormFactory)
A form is a FinePrint job that has been saved so that new printed output can be placed on 
top of it.    For example, forms can be used to save your letterhead so that you do not need 
to purchase, store and load pre-printed letterhead.    You can also use forms for invoices, 
purchase orders, memoranda, etc.

Creating a form

1.    Create the form in any application and select the Print command.    Select the FinePrint 
driver.

2.    When the FinePrint dialog appears, click the FormFactory (patent pending) tab.    Your 
document will appear in the preview window.

3.    Select the New button and name your form.    Examples might be, "My letterhead", or 
"Invoice form".

4.    Depending on the length of the form, you will have additional options that control how 
the form will be printed.    

5.    Set the printing option.    The form pages will be repeated in sequence with any 
document pages unless either of the two options are selected:

Print on first page only - this option applies to single page forms only and signifies that the 
form will be printed on the first page of the document and not on subsequent pages.

Repeat second page - this option applies to 2 page forms only.    It signifies that instead of 
repeating the sequence of two pages, that the second page of the form should be used for 
all document pages other than the first.

5.    That's it!    Now, go back to the Layout tab.    If you want you can print your form or you 
can exit by clicking the Cancel button.

Using Forms

Now that the form is created, you can print other jobs on top of it.    This is done as follows:

Print the job in the normal FinePrint method.    When the dialog box appears, select the name
of the form you want from the Form combo box near the bottom of the screen.    The preview
window will display your current print job on top of the selected form.

It is recommended that you use the original setting in the Margins combo box when using 
forms for final output.    This will ensure that the alignment is true to the original paper 
dimensions.

Editing the Form List

Rename button - renames the selected form.
Delete button - deletes the selected form.




